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1. Introduction

Thank you for purchasing a Redback Systems product. This manual provides you with
directions on the device installation and operation as well as a brief introduction to the
RedSolve software. Please read the following instructions carefully.

NOTE: Please read this manual carefully before installing and operating your new
RS40k spectrometer. It is important to understand and follow all safety, installation,
operation, and maintenance procedures as stated to ensure proper functionality.

2. Requirements

To ensure your computer can operate the device software and drivers, please read the
hardware and software system requirements below. Note that at this time only the
Windows operating system is supported. In addition to hardware requirements, an
internet connection is required for downloading the device driver, software and manual.

Minimum hardware and software requirements:

● Operating System: Windows 10 (64 bit)
● Processor: Intel Core i5 or AMD Ryzen 5
● USB 2.0 port
● RAM: 8.0 GB
● HDD: 256 GB internal hard drive

Recommended hardware and software requirements:

● Operating System: Windows 10 (64 bit)
● Processor: Intel Core i7 or AMD Ryzen 7
● USB 3.0 high speed port (preferred)
● RAM: 16.0 GB RAM
● HDD: 1TB internal SSD hard drive
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3. Warnings

● Your Redback Systems spectrometer is a precision optical instrument. Always
handle it with the level of care appropriate for such instruments.

● There are no user serviceable parts inside the spectrometer housing or inside the
camera. Subsequently, both componentsMUST NOT be opened.

● Care should be taken such that the camera does not overheat. The camera’s air
vents must not be blocked.

● Your Redback Systems spectrometer does not contain a shutter. Please avoid
illuminating the detector with high-power lasers.
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4. Safety Precautions

4.1 General Handling

● Handle the spectrometer with care.
● Make sure the spectrometer is placed on a flat surface with its red lid at the top.
● Do not operate in damp or wet conditions with RH >70%.
● Do not use the spectrometer in an outdoor environment.
● Do not disassemble the spectrometer or attempt to modify or repair it.
● Do not subject the spectrometer to mechanical shock or vibration.
● Do not cover the cooled detector.
● Do not operate the spectrometer in explosive environments.
● Only use the electrical cables provided.
● Avoid static electricity.

4.2 Fibre Installation

● Take care when installing the optical fibre.
● Only use FC/PC fibre connectors as specified in Section 5.3 of this manual.
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5. Installation

5.1 Contents of Shipment

Please inspect the device mechanically and unpack the contents in a clean, dry, and
EDS-free area. Verify that you have received the following items with the package:

● RS40k spectrometer in Pelican 1520 storage case
● 12V/5A power supply and cable
● USB 3.0 cable
● S405-XP and 780HP single-mode fibres with FC/PC to FC/APC connectors
● USB flash drive with unique wavelength calibration file
● Desiccant container filled with silica gel
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5.2 Spectrometer Interfaces

NOTE: Do not connect the RS40k echelle spectrometer to any PC prior to installing
the software application and device drivers. Please use the included USB 3.0 cable to
connect the detector with your PC or laptop.

The spectrometer interfaces are shown in Figure 1. The device has four mounting slots
which are machined into the aluminium housing. Off-the-shelf mounting hardware (e.g.
Thorlabs CL5A) can be used to secure the device onto the optical table. Make sure not
to overtighten the screws as this could result in permanent deformation of the rubber
feet and can also exert stress onto the housing which can negatively affect the
performance of the device.

Figure 1: RS40k spectrometer ports and interfaces: (1) fibre input, (2) mounting slots,
(3) 12V power, (4) USB 3.0 interface, and (5) Trigger IN/OUT. Note, the Trigger IN/OUT

interface are optional and not activated by default.
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5.3 Optical Fibre

The RS40k is specifically designed to work seamlessly with single-mode fibres that are
equipped with FC/PC connectors. When you receive the device, it will come with two
hybrid single-mode fibres (SMFs) that are suitable for your spectrometer's wavelength
range. In Figure 2, you can see a depiction of commonly utilised single-mode fibres,
which effectively cover the wavelength range of your spectrometer. The solid bar shows
the transmission range given in the supplier’s datasheet. The measured range can vary
from fibre to fibre and often exceeds the theoretical limit (see hatched area).

Figure 2: Selection of standard SMFs compatible with the RS40k wavelength range. The
hatched area indicates the measured fibre transmission, exceeding the theoretical range.

Butt coupling FC/APC fibres to FC/PC fibres may result in light loss of up to 50%. We
recommend using hybrid patch cables with FC/PC and FC/APC connectors if your
experiment is based on APC fibres. Your RS40k package includes a set of hybrid patch
cables (Thorlabs S405-XP and Thorlabs 780HP) which cover the 420-950 nm range.

NOTE: If your system requires fibres with FC/APC connectors please use the included
hybrid patch cables to adapt your fibre system to the RS40k spectrometer.

Testing of the device has revealed that light leakage through coloured furcation tubes is
able to be detected in the NIR range of the spectrum. Therefore, for best results, we
recommend using fibres embedded in black ormetal furcation tubes only. Alternatively,
the device should be operated with the room lights switched off.
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5.3.1 Cleaning Optical Fibre Connectors
The optical fibre must be thoroughly cleaned before plugging into the device. Please
ensure that the fibre tip is free of scratches, dust, or any kind of dirt to achieve the best
possible performance. We recommend using a fibre inspection microscope to regularly
inspect the fibre-end faces at high magnification. Clean the connector ends in case dust
and dirt has settled on the fibre tip. Figure 3 shows a successfully cleaned fibre surface
for reference (see right image).

Figure 3: Microscope images of a dirty (left) and clean (right) fibre end.
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6. Software

6.1 Updates + Downloads

Each spectrometer is shipped with the current version of RedSolve at production date.
The latest version of the RedSolve can be downloaded from our website:
www.redback.systems/downloads.

Prior to installing any updated software, you should first disconnect the spectrometer
from the computer and uninstall the current software completely from the computer.

6.1.1 Check your software version
You can check what version of the RedSolve software you have installed, under the
Options file menu click About (Figure 4).

Figure 4: The About dialog is accessible from the Help menu.
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6.2 Software Installation

1. Prior to commencing the installation process, terminate and exit any programs
currently running on your computer.

2. Ensure the spectrometer is not connected to the computer.
3. Install the hardware driver from your USB drive
4. On the install options page you only need to select the driver, as shown below:

Figure 5: The device installation wizard. Select Drivers only and proceed with the installation.

5. Download and run the latest RedSolve Setup [version].exe file from our website
and follow the prompts presented by the install wizard.

6. After successfully installing the software, connect the RS40k spectrometer to
your computer via the provided USB 3.0 cable.

7. Run RedSolve, then open the Settings dialog from the Options menu. Load the
calibration file from the provided USB flash drive.
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6.3 Wavelength Calibration

Each spectrometer is shipped with a unique calibration file. As part of the spectrometer
installation process you must first load your calibration data from the USB drive. If no
calibration file has been previously used, you will be prompted by the below dialogue.
Once the calibration file is loaded you can use RedSolve to acquire data.

Figure 6: A warning to load the calibration file is shown on startup.

Clicking OK will take you directly to the settings window where you can load the
included calibration file. You must click OK or Apply in the settings window to activate
the calibration file. The Settings dialog can also be accessed from the Optionsmenu.

Figure 7: Load your calibration file from the USB drive into RedSolve.
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6.4 User Interface

Below (Figure 8) is an annotated screenshot of the RedSolve user interface.

Figure 8: The RedSolve main window.

The annotated sections of the user interface are:
1. Measurement toolbar.
2. Data visualisation toolbar.
3. Full-spectrum thumbnail plot. This panel will always display the full data range

acquired.
4. Status bar.
5. Regions of Interest (ROIs). A region of interest (ROI) can be created to inspect a

subset of the collected data. Multiple ROI panels can be created.
6. Detector temperature and relative humidity (for cooled detectors only).
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6.4.1 Toolbar Actions
All action buttons and menu selections contain mouseover text where appropriate. The
following table briefly describes the most commonly used actions.

Acquire Exposes the detector for the set exposure
duration and converts the image into data.

Exposure time The detector exposure time in seconds.

Live view Refreshes the spectrum as quickly as possible.
The refresh rate is limited by the exposure time
and the data processing time. No data is recorded
from Live view.

Save Saves the spectrum data to a *.csv file. The user
will be prompted to confirm the saving directory
and filename.

Load Load previously saved data for further exploration
or processing.

New ROI Creates a new region of interest (ROI).

Set Dark Set the current data as a dark frame to allow dark
subtraction.

Set Flat Set the current data as a spectrally flat frame to
allow amplitude compensation for the echelle
blaze angle modulation.

Subtract Dark Subtract the current dark frame from the
measured data. Can be toggled on and off as
desired without reacquiring data.

Show Flattened Apply the flat-fielding compensation for the
echelle blaze angle modulation. Useful when
visualising broader spectral features.
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6.4.2 Spectrum Acquisition
The detector chip provided in your Redback Systems spectrometer may have higher
sensitivity than other comparable spectrometers. For this reason, to avoid saturation of
the detector we recommend starting your measurements with shorter exposure times,
and incrementing the exposure time as required. The dashed line in the overview plot
shows the maximum intensity before saturation. Breaching the exposure limit can
cause light bleeding into adjacent orders which generates false signals in the spectrum.
Please stay below the limit in your region of interest to avoid distorted data.

NOTE: Stay below the saturation limit in your region of interest to avoid distorted data
and artificially created peaks from light bleeding into adjacent orders.

6.4.3 Saving data
To save your data, click on the Save button and select the desired file directory. The
complete data array will be saved in *.csv file format. Relevant metadata (e.g. exposure
time, acquisition date, etc.) will be saved in the file header. A presentation-ready image
showing a screenshot of the data is also saved (see example in Figure 9).

Figure 9: Example of a presentation-ready image.
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6.4.4 Regions of interest (ROIs)
To give users instant access to data analysis, one can create multiple regions of interest
(ROIs) in the main window. Many ROIs can be created. If the number of ROIs opened
exceeds the available screen real-estate, then new ROI windows will be created as tabs.

6.4.5 Dark Screen
Selecting the Dark screen option from the View menu changes the background colour
from light to dark for low-light experiments. Icons and toolbar buttons are not affected
by the dark screen mode (Figure 10).

Figure 10: RedSolve dark screen mode.
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6.4.6 Periodic Acquire
The Periodic Acquire function will automatically acquire data at defined intervals, and
for either a fixed or infinite number of repetitions. Additionally, the user can toggle if they
would like to save the data from each acquisition.

Figure 11: The Periodic Acquire menu, located within the Tools menu.

Figure 11 shows the Periodic Acquire menu. When the Auto-refresh button is engaged
the measurement will run with the input Interval and Repeats parameters. Setting
Repeats to “0” will continue the measurement series indefinitely. Toggling Save on ↻ will
save the acquired data after each acquisition.
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6.4.7 Dark Calibration
Modern CMOS detectors offer a number of advantages compared to more traditional
CCD detectors, including increased sensitivity over a wider wavelength range and faster
detector read-out. Similarly to CCD detectors, their performance, however, strongly
depends on temperature. As a consequence, some background counts from thermal
electrons are typically recorded, even when no light hits the detector chip. First-order
data reduction must be applied to all recorded images in order to remove noise
associated with the CMOS detector.

The RS40k has a Peltier-cooled scientific CMOS sensor to minimise this effect. The
cooler is activated in the device software RedSolve. The lowest temperature that can be
reached is 40°C below ambient. We recommend operating the detector at about -10°C
(set by default) to achieve the best performance and sensitivity. The sensor temperature
and detector chamber humidity is always displayed in the lower right corner of the
software interface (Figure 12).

Figure 12: The sensor temperature is shown in the lower right corner of the software interface.
If the sensor temperature is not within ±1°C of the set temperature it will be highlighted in red.

To remind the user, a warning will be displayed if an acquisition is attempted when the
sensor has not yet cooled to the set point (Figure 13).

Figure 13: The user will be cautioned if the sensor temperature is not within ±1°C of the set
temperature. Note, the default setting is -10°C.
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A dark frame is recorded under the same conditions (exposure time) as the science
frame. The following steps must be followed to successfully remove dark current from
the science exposures:

1. Switch off the light source or cover the single-mode fibre input.
2. Acquire a dark frame with the same exposure time as the science frame.
3. Click the Set Dark button in the toolbar.

After the dark frame has been set, the Subtract Dark toolbar button can be toggled to
automatically remove the dark signal from any recorded spectra (Figure 14).

NOTE: You must repeat steps 1-3 whenever you change the exposure time.

Figure 14: Subtract Dark icon activated.
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6.4.8 Flat-Field Calibration
Spectrometers, like any optical instrument, can have non-uniformities in their detector
array and optical system. These non-uniformities can lead to variations in sensitivity
across different wavelengths or regions of the detector. Flat-field calibration helps to
compensate for these non-uniformities by normalising the response of the device
across the entire wavelength range. A complete data set acquired with the RS40k
spectrometer includes a science frame with real data, a flat-field (i.e. white-light) frame,
and a dark frame. The following steps describe how you acquire and process the data:

1. Switch off the light source or cover the single-mode fibre input.
2. Acquire an exposure with the same settings (exposure time, etc.) that will be

used for your measurement.
3. Click the Set Dark button in the toolbar.
4. Uncover the fibre and take an image of a broad-band light source, preferably use

a tungsten-quartz lamp (e.g. Thorlabs SLS201L or similar).
5. Acquire an exposure with an exposure setting lower than the overexposure limit

(typically around 170 kcounts at 650 nm). Stay below the exposure limit over the
entire range (→ observe overview plot).

6. Click the Set Flat button in the toolbar once the white-light spectrum is acquired.

After the dark and white-light frames have been set, the Show Flattened toolbar button
can be toggled to automatically flatten then spectrum any recorded science spectra.

Figure 15: Subtract Dark and Show Flattened icons simultaneously activated.

© Redback Systems Pty Ltd v1.5 21



6.5 Python API

It’s your hardware, control it how you like. Our Python-based API makes it easy to
automate measurements and seamlessly integrate spectroscopy into your workflow.
Capture the data in line with post-processing and analysis.
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6.6 Troubleshooting
If you encounter any issues during the installation or operation of RedSolve, visit our
website for support resources. Our customer support team is also available to assist
you with any questions or concerns you may have.

NOTE: RedSolve software creates log files in the user appdata directory. These can
be ignored by the user, but are included for the purpose of debugging.

6.6.1 Wavelength offset correction
Your RS40k wavelength calibration is factory set. Please handle the spectrometer with
care as it is a precision instrument. If you believe the RS40k requires recalibration,
please contact us (see Section 8).
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6.5.1 High detector humidity warning
The sCMOS detector used in the RS40k spectrometer has an O-ring sealed chamber
which is back-filled with argon gas to create an inert atmosphere. The O-ring seal may
leak over time and water vapour is able to diffuse into the chamber. If the internal
humidity is too high condensation can form on the detector cover glass when the
detector is cooled below the dew point. Condensation on the detector glass manifests
itself as a loss in signal strength and/or deep trenches in the recorded spectrum.
RedSolve monitors the relative humidity inside the detector chamber and displays the
current value at the bottom right corner. If the detector chamber humidity value exceeds
a certain threshold, a warning message will notify the user. Please immediately stop
using the spectrometer and follow the steps below:

1.) Remove the slotted screw on the top side of the detector as shown below.

Figure 16: CMOS detector with slotted top screw and silicone O-ring.
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2.) Remove polyimide tape and plastic screw from desiccant container. Make sure the
silicone O-ring is attached to the desiccant container front piece, and the mesh is
on the bottom of the container when refilling with fresh or recycled silica gel.

Figure 17: Photo of desiccant container (left) and container components (right).

3.) Install desiccant container and wait for at least 48 hours prior to using the device.

Figure 18: CMOS detector with installed desiccant container.

NOTE: The desiccant container is shipped with orange colored silica gel. The orange
gel will turn green if the moisture content is above a certain percentage. You can
either bake the container or refill with any dry silica gel.
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7. Device properties

7.1 Optical Parameters

Spectral coverage 430-950 nm (simultaneous coverage1)
23,256 - 10,520 cm-1

Resolving power [R=λ/dλ] 44,000-34,000 (430-950 nm)

Spectral Resolution [dλ] ~16 pm (FWHM) at 632.8 nm

Wavelength repeatability < 20 pm

Efficiency 20% (430 nm), 54% (600 nm), 14% (950 nm)

Fibre input standard SMF FC/PC (see Section 5.3)

Detector cooled sCMOS, QE~95% at 580 nm

Exposure time 0.001-20 s

Acquisition rate <5 Hz

1 Wavelength range limited to SMF bandwidth (see Section 5.3).

7.2 Device Parameters

Weight 8.3 kg (18.1 lbs)

Temperature operating range 15-35°C

Humidity operating range 0-70% non-condensing

Power supply 12V, 5A

Computer interface USB 3.0 (USB 2.0 compatible)

© Redback Systems Pty Ltd v1.5 26



7.3 Device Dimensions

Figure 19: Dimensions of the RS40k echelle spectrometer.

© Redback Systems Pty Ltd v1.5 27



8. Technical Support

Should you have any questions or require further assistance, our dedicated customer
support team is here to assist you. Reach out to us via the details below. RedSolve
software creates log files in the user appdata directory, which can be included in with
your enquiry.

Redback Systems Technical Support

E-Mail: support@redback.systems
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